Sure-Real technical manual
Introduction
Sure-Real is modelling tool for multi-scenario trial development. It has been
developed as part of the IMI GetReal project. The tool represents an environment for
interactive study design incorporating a number of models. The different elements
relating to the tool and models is shown here (Figure 1).

Figure 1 Structure showing the different elements of modelling tool

The modelling tool is designed for multi-scenario development plans, containing a
data repository and appropriate models, including optional interaction with trial
simulation software (such as Kerus software from Exploristics
[https://www.exploristics.com]). Interactive user interaction is realised through a user
friendly customised visual interface. Additional outputs include reporting and
visualisations.
The core of the tool is realised as a Microsoft Excel Add-In, with data repositories
and models, incorporated in Excel spreadsheet(s). It requires Microsoft Excel and
Microsoft Visio.

Requirements
Creating scenarios in Sure-Real requires the following software:




Windows operating system
Microsoft Excel 2010 or higher
Microsoft Visio Professional 2010 or higher

Installation
Select the Sure-Real installer executable, which will show an installation wizard
dialog to guide de installation process. Successful installation of Sure-Real can be
verified by opening Excel which should show the Sure-Real menu ribbon, as shown
in the next section. The example model will be installed in the location:
My Documents \ Sure-Real \ SureReal example.xlsx

Using Sure-Real
The main user interface of Sure-Real is the Visio interface, with addition of a custom
menu ribbon both in Excel (Figure 2) and Visio (Figure 3). Three types of interfaces
have been designed, each of which allows direct interaction with the scenario data
through the Shape Data interface. Each scenario is made up of a separate SureReal Excel worksheet.

Figure 2 Sure-Real Excel menu ribbon

The Sure-Real Excel menu exposes the following functionality:


Generating interactive visualisations of the currently active worksheet
o Timeline Designer: interact with all scenario time lines
o Patient Experience Manager: interact with patient flows
o Population Manager: interact with population branching

Figure 3 Sure-Real Visio menu ribbon

The Sure-Real Visio menu exposes the following functionality:


Generating interactive visualisations of selected scenarios
o Timeline Designer: interact with all scenario time lines
o Patient Experience Manager: interact with patient flows
o Population Manager: interact with population branching



Interaction with trial simulation software



Comparing two scenarios



Generating graphs of modelled data

When generating a scenario visualisation diagram (Timeline, Patient Experience or
Population), a Visio file will be generated and automatically saved to the same
location where the Sure-Real Excel file is located. The file name will be generated
using the Sure-Real Excel file (e.g. ‘SureReal example’), the scenario worksheet
label (e.g. ‘Test Case’) and the Visio template name (e.g. ‘time_line’) and
automatically concatenated (e.g.: ‘SureReal example Test Case time_line’).
The main Sure-Real user interface can be accessed in two ways:


Open a Sure-Real Excel model file, and in the Sure-Real menu select one of
the options in the Diagram menu



Open an existing Sure-Real Visio diagram file, which will automatically
attempt to open the corresponding Sure-Real Excel model file

Timeline Designer
The Timeline Designer interface (Figure 4) visualises the Time Lines as horizontal
bars with time represented as linear scale on the horizontal axis. These then contain
coloured bars representing time line intervals, and on their right showing Endpoints.
Endpoints can be used for study outcomes and can contain numeric values. Arms
can be included directly below timeline intervals. Additionally, Events can be added
and shown as vertical lines across the timeline. Finally, Legends can be included on
the bottom right.
These items can be added, modified, or removed in the diagram. To add an item,
select it on the Shapes view on the left had side of the window, and drag it into the
main diagram. To remove an item, select it in the diagram and press the Delete key,
or from the item’s context menu select Cut. Key properties can be modified by
moving an item across the time scale, or repositioning it relative to other Time Lines.
Other properties for Time Lines, Endpoints, Arms, Events and Legends can be
accessed via Shape Data. (Shape Data can be shown by enabling Shape Data
Window in the Data menu (for Visio Pro), or by selecting an item in the diagram and
from the context menu selecting Data -> Shape Data.) Shape Data is shown in the
view on the right hand side of the window. Properties like Label or Value can then be
modified by changing the content of the corresponding Shape Data entry.

Figure 4 Sure-Real Timeline Designer

Patient Experience Manager
The Patient Experience Manager (Figure 5) visualises patient flows which shows
patient numbers, costs and other parameters, and relationships between each of
these. Dynamic labels and values can be shown on branches and nodes.
Like the Timeline Designer, items can be added, modified, or removed in the
diagram. To add an item, select it on the Shapes view on the left had side of the
window, and drag it into the main diagram. To remove an item, select it in the
diagram and press the Delete key, or from the item’s context menu select Cut. Item
contents can be modifies through the Shape Data entries.
Connections between nodes can be made using the special Connector item from the
Shapes view. It can subsequently be connected to nodes by dragging each end of
the connector over a node.

Figure 5 Sure-Real Patient Experience Manager

Population Manager
The Population Manager (Figure 6) visualises subject populations, and how these
divide and recombine based on characteristics such as geographical region.
Corresponding values can be shown on nodes and on branches.
Like the Timeline Designer and Patient Manager, items can be added, modified, or
removed in the diagram. To add an item, select it on the Shapes view on the left had
side of the window, and drag it into the main diagram. To remove an item, select it in
the diagram and press the Delete key, or from the item’s context menu select Cut.
Item contents can be modifies through the Shape Data entries.
Connections between nodes can be made using the special Connector item, like in
the Patient Manager, by dragging each end of the connector over a node.

Figure 6 Sure-Real Population Manager

Scenario comparisons
Scenario comparisons are performed by selecting a Comparison reference from the
Comparison section in the Visio menu ribbon (see Figure 3). This will determine the
difference between the selected scenario, relative to the currently open scenario. An
example of timelines is shown in Figure 7). All differences are highlighted, including
timeline differences indicated by gradients, where green indicates an increase and
red a decrease. Differences are also shown of any numerical values, and the same
colour coding used. In contrast to the other types of diagrams, scenario comparisons
are not dynamically linked to data sources and so will not automatically update when
the associated data sources change, and are not automatically saved.

Figure 7 Comparison of scenario timelines

Designing scenarios
Sure-Real scenarios are designed starting with an Excel Sure-Real template
worksheet containing the following Named Ranges:












TITLE
INTERVALS
ENDPOINTS
ARMS
EVENTS
LEGENDS
FLOW_NODES
FLOW_CONNECTIONS
POPULATION_NODES
POPULATION_CONNECTIONS
GRAPHTYPES

: General scenario title
: Timeline Designer
: Timeline Designer
: Timeline Designer
: Timeline Designer
: Timeline Designer
: Patient Experience Manager
: Patient Experience Manager
: Population Manager
: Population Manager
: Graph definitions

Each Named Range refers to a table including a heading with column labels (see
Figure 8). Required columns are ‘id’ representing a unique identifier for each row in
the table, and Master, which refers to a Visio Master Shape. The unique identifier
may further be referred to in other tables, for example, the Timeline Interval that the
Arm or Endpoint belongs to, or the Nodes that a Connection is connected to. Though
the columns can vary per data source, common columns are Label representing the
main label of an item and Value representing a corresponding (numeric) value.
These form the main data sources that Sure-Real links to.

Figure 8 Sure-Real Excel worksheet including various named ranges (highlighted in red)

Sure-Real links these data sources to template files in Visio. For each data source
type (Timeline, Patient Experience, Population) a specific Visio template file is
defined. The template files can either be Visio Stencil (.VSS) files containing a
number of Visio Master Shapes, or Visio Template (.VST) files containing a Visio
Drawing template which also includes a linked Visio Stencil file. Each Excel data
source row defines the Visio Master Shape it uses (see Figure 9). The Master
Shapes will contain Shape Data (see Figure 10) entries that correspond to Excel
data source column names. Before defining Shape Data, the Developer Mode
should be enabled (in File -> Options, in the Advanced section)

Figure 9 Visio Master Shapes (for Timelines data source type)

Figure 10 Visio Shape Data (for Timelines Interval data source)

Figure 11 Visio Define Shape Data dialog

To define Shape Data that Sure-Real will link to Excel, the following name format
needs to be observed in Visio. The Label field can be chosen freely, but the Name
should be the same value preceded by ‘vis’ (e.g. if the value in the Label field is
‘Label’, the Name should be set to ‘visLabel’) (see Figure 11). Note that before
defining Shape Data, the Developer Mode needs to be enabled, which will reveal the
Name field. The Type can be set corresponding to the type of the data the field
would hold. In case this field can contain mixed values, the Type ‘String’ should be
chosen.
A number of Master Shapes use the Data Graph functionality provided in Visio Pro,
which is accessed from the Data menu in Visio. This allows a single Shape to have
various text fields and additional graphs attached to it. These custom fields and
graphs are linked to the Shape Data.

End User Licence Agreement
The Sure-Real software (" software") and all information contained in are available for
use subject to the following terms and conditions. By accessing the software, you
agree to these terms and conditions of use.

Background
1.

The software and its associated user manuals are co-owned by the National
Institute for Health and Care Excellence (“NICE”) a non-departmental public
body established under primary legislation and based at Level 1, City Tower,
Piccadilly Plaza, Manchester, M1 4BT, United Kingdom ("NICE", "us", "our" or
"we") and Massachusetts Institute of Technology New Drug Development
Paradigms Initiative, 77 Massachusetts Avenue, Cambridge, MA 02139-4307,
United States (“MIT NEWDIGS”).

2.

These terms and conditions apply to the use of any of the software and user
manuals.

3.

The software is an output from the IMI GetReal project. It represents a tool
designed for multi-scenario case studies aiming to provide insight regarding the
use of real world evidence in clinical drug development.

4.

Users must only use the software for purposes consistent with these Terms of
Use.

General
5. The software is publically accessible, an envisaged of particular use to
manufacturers, HTA agencies and academia, and to provide visual output for
anyone involved in health technologies.

Your use of the software
6. You may use the software for educational, research or other such reasonable
purposes that do not violate our terms and conditions.
7. You may only use the software for lawful purposes. You may download, install,
copy and distribute the software.
8. You may not use, and shall take all reasonable steps to ensure that no other
person uses the software in a way that does not comply with the terms of any
laws applicable to you or that is in any way unlawful.
9. You may add, edit and copy text or content in the all the fields / cells for editing.
10. You may use the scenarios, outputs and visualisations of the software only for
the purposes as described in clause 6 and for commercial use.
11. Except for your use of the software in accordance with these Terms of Use You
agree:

a) to comply with any legal notices contained in the software and its
associated documents;
b) to respect and comply with the legal rights of others, in particular our
rights (including our rights in copyright and trade marks), and the rights
of our licensors;
c) except as described in clause 10, you may not to use the software for
any commercial gain, personal or otherwise, nor to sell or trade in any of
the content or other material copied or downloaded from the software
without our express written permission;
d) except as described in clause 9, you may not to change any of the text
or content contained in the software or merge it with any other
software or programme, or forge headers or otherwise manipulate
identifiers in order to disguise the origin of any content; and
e) not to present or use material from the software in a way that is
misleading.

Intellectual property rights
12. You acknowledge that all rights in copyright, patents, design rights, trade marks
and other intellectual property rights (whether registered, capable of
registration or otherwise) throughout the world, ("IP Rights") in the software
(including in all content) are owned by NICE and MIT NEWDIGS and/or our
licensors, other third parties or are subject to Crown copyright, for the full
duration of such rights.
13. Except for your use of the software in accordance with these Terms of Use, you
are granted no IP Rights in respect of the software or its content.
14. You may print, copy or download the content from the software for educational
and not-for-profit purposes only and provided always that:
1. NICE and MIT are acknowledged as the source;
2. all titles and credits are included; and
3. You comply with any legal notice contained in the software.
This permission is revocable by NICE at any time.
15. All trademarks, logos, titles, brand and product names ("the Trade Marks") which
are featured in the software are owned by our licensors.
16. You may only use or refer to the Trade Marks which are included in those
extracts from the software downloaded, copied or printed by you in accordance
with these Terms of Use. Otherwise you must not offer or distribute any
products or services under or by reference to the Trade Marks, or otherwise
reproduce any of the Trade Marks without our express written consent
17. Reproduction, publication or distribution of the content from the software
including NICE and MIT copyright material for commercial purposes is not
permitted without the express written permission of NICE.

Availability of the software
18. As a third party website is hosting the software and associated manuals we
make no representation or guarantees as to the availability of the software.
19. We reserve the right to withdraw access to the software for periods of time in
order to modify any of the content, for scheduled or unscheduled maintenance
and for other purposes, without notice to you.
20. As you will gain access to the software via third party telecommunications
networks, you acknowledge that NICE cannot guarantee that the availability of
the software and its access will not be uninterrupted or error free. Similarly we
cannot guarantee that the transmission of any information over such
telecommunications networks will be secure nor that you will be able to access
the software at all times.
21. The software is therefore provided to you on an “as is” and “as and when
available” basis, and your use of the software is at your own risk.

Disclaimers
22. We have processes in place to seek to ensure that the content the software and
associated manuals are accurate. However, we give no assurances regarding the
currency, accuracy or applicability of any of the software’s content.
23. Due to the nature of the software we cannot guarantee the prompt editing or
removal of any inappropriate or inaccurate information. If you find any
information that is inaccurate or inappropriate then please contact us as below.
24. While we use virus checkers to check the content of software we are unable to
guarantee that the software will never be faulty, nor that it will work
continuously, nor that it will be maintained in a fully operational condition nor
virus and/or error free. However we will use reasonable endeavours to correct
serious faults reported by you as soon as we reasonably can.
25. You should always check any content before downloading. The software, its
installation and any content is downloaded by you at your own risk and on the
basis that you will be solely responsible for any damage to your computer
system or loss of data that result from the download of such content.
26. Without prejudice to any other limitations or exclusions of our liability in these
Terms of Use we shall have no liability whatsoever in respect of any failure on
our part to repair a fault in the software or to provide continuous access to it.
27. Without prejudice to any other limitations or exclusions of our liability in these
Terms of Use we shall have no liability whatsoever in respect of any inability on
your part to obtain access to the software whether through any denial of
service, attack or otherwise.
28. You are responsible for the provision of and payment for all telecommunications
services necessary to use the software and all hardware, equipment and other
services (including but not limited to computers, modems and any other
communication equipment) necessary to use the software.

29. We provide this software to you without any conditions, warranties, or
guarantees whether express or implied, including but not limited to any implied
warranties or conditions as to the satisfactory quality or fitness for a particular
purpose, which are expressly excluded to the extent permitted by law.

IMI GetReal Consortium Disclaimer
30. It is our goal to minimise disruption caused by technical errors. However, some
data or information in the software may have been created or structured in files
or formats that are not error-free and we cannot guarantee that our service will
not be interrupted or otherwise affected by such problems. The consortium
accepts no responsibility whatsoever with regard to such problems incurred as a
result of using the software.
31. The processes described and conclusions drawn from the work presented in the
software relate to case study design to establish relative effectiveness in clinical
drug development. This software neither replaces nor is intended to replace or
comment on any regulatory, access, or funding decision made by national
regulatory agencies, the European Medicines Agency, national Health
Technology Assessment (HTA) agencies or other payers, or to replace formal
scientific advice by these organisations. Actions taken by users following results
from this software do not guarantee access or funding by HTA agencies or
payers.
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Our liability
33. Nothing in these Terms of Use shall or shall be deemed to limit our liability to
you for any personal injury or death caused by our negligence or for any fraud
perpetrated by us.
34. Subject to the above paragraphs you acknowledge that in respect of your use of
the software including the documents published on any third party host site we
shall not be liable to you in contract, tort (including negligence) or otherwise for:
a. any damage or loss arising from the consequences of viruses received
by you via the software or of our failure to provide the software in
accordance with these Terms of Use;
b. any economic losses (including loss of profits) any indirect or
consequential losses, loss of data, goodwill or reputation, or for any

wasted expense including but limited to losses caused by viruses,
and any other liability we may have to you whether in contract, tort
(including negligence) or otherwise for any loss or damage suffered by
you in relation to the software (including any information contained on
it) is limited to £500.
35. In any event we will not be liable for any failure to perform our obligations
under these Terms of Use if we are prevented from doing so by an event
beyond our reasonable control.

Your liability
36. You agree to indemnify and hold us harmless from any:
a. claims (including third party claims);
b. losses, demands, costs, expenses (including legal costs and expenses);
c. fines; and/or
d. any other liabilities whatsoever (including (without limitation)) any
liability arising out of any action brought against us for
misrepresentation or negligent misstatement arising from any access to
or use of the software by you, or by any person who may be authorised
by you or for whom you are responsible to the extent such use is in
breach of these Terms of Use and/or unlawful, and save always to the
extent that any such claims, losses, demands, costs, expenses, fines or
other liabilities arise directly due to our negligence or default.
37. You acknowledge that this indemnity is appropriate and reasonable given the
nature of the software, and that you are accessing the software at no additional
charge to yourself.

Jurisdiction
38. The laws of England shall apply exclusively to these Terms of Use and to all
matters relating to use of the software. Any cause of action arising under these
Terms of Use or the use of the software shall be subject to the exclusive
jurisdiction of the courts of England and Wales.

Amending these terms of use
39. From time to time NICE may at its sole discretion amend these Terms of Use.
Your continuing use of the software constitutes your acceptance of and
agreement to any changed terms and conditions.

Enforceability
40. If any provision of these Terms of Use is held to be invalid or unenforceable,
such provision shall be struck out and the remaining provisions shall be
enforced.

Interpretation
41. Headings are for reference purposes only and in no way define, limit, construe
or describe the scope or extent of such section.

No waiver
42. Our failure to act with respect to a breach of these Terms of Use by you or
others does not waive our right to act with respect to subsequent or similar
breaches.

Entire Agreement
43. These Terms of Use set forth the entire understanding and agreement between
you, NICE and its partners with respect to your use of the software and your
relationship, from that use, with us.

Further information
44. If you would like to make any comment or complaint about the software
please contact us:
Mark Trusheim (MIT):

Trusheim@MIT.edu

Joost de Folter (NICE):

Joost.deFolter@NICE.org.uk

Freedom of Information
https://www.nice.org.uk/freedom-of-information

